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LCD TouchPanel (924)

Installation and User Guide

Product description
Thank you for choosing a Helvar product, and welcome 
to our growing family of customers around the world. 
By choosing Helvar, you have invested in great value 
technology that we hope you will enjoy using for many 
years. This guide is designed to help you get the most from 
your TouchPanel. Here you will learn about its features, 
its operation and maintenance. To learn about TouchPanel 
installation and wiring, see the installation leaflet 
(document 7860140, supplied with this product).

TouchPanel requires some configuration 
before it can be used for the first time. To 
learn more, see section 3.

To learn about your lighting system, and how 
TouchPanel works with it, see section 21. 
This is highly recommended if you intend to 
customize TouchPanel’s operation.

Menus and controls
To learn how to use the on-screen 
menus and controls, see section 2.
To learn how to change screen 
content, see section 8.

Bezel
To learn about care and 
cleaning the bezel and 
screen, see section 18.

Touch-sensitive screen
To learn how to use the touch 
screen, see section 1.1

Backlight
To learn about using and 
configuring the backlight, see 
section 17.

Remote control
To learn how to configure 
TouchPanel for use with a 
remote control, see section 11.
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Key to symbols used in this guide

Master Panel
A section with this symbol beside the heading applies to 
TouchPanel in Master Panel mode.

Toolbox Slave
A section with this symbol beside the heading applies to 
TouchPanel in Toolbox Slave Panel mode.

Workshop Slave
A section with this symbol beside the heading applies to 
TouchPanel in Workshop Slave mode.

Designer Slave
A section with this symbol beside the heading applies to 
TouchPanel in Designer Slave mode.

Sections with no symbol beside them apply to all TouchPanel 
modes of operation. To learn about modes of operation, see 
section 3.2.

Tip
An item with this symbol beside it provides extra information to 
help you get more from TouchPanel.

Alert
An item with this symbol beside it contains information 
and warnings about the implications of certain features of 
TouchPanel, plus information to help you use TouchPanel safely.
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1. Dos and Don’ts

Do not allow TouchPanel to 
become wet or immersed in 
any liquid.

TouchPanel is designed to 
withstand mild impacts, but 
it may be damaged if struck 
too hard. You need only 
press the screen gently to 
select an item. As a simple 
rule, if the picture becomes 
distorted when you press 
the screen, then you are 
pressing it too hard.

For ease of use we 
recommend using a stylus 
if you are Configuring 
TouchPanel extensively.

Do not press the screen 
with hard or sharp objects, 
or with a writing tool 
such as a pen, as this 
may damage or mark the 
screen.

Electric shock hazard
Do not dismantle TouchPanel!
There are no customer-serviceable 
components inside. If you suspect that 
a component is faulty, contact your 
supplier for assistance.

To learn about Technical Support, 
see section 20.1.

To learn how to clean TouchPanel, see 
section 18.

You can also control the lighting with 
the Remote Control Handset (available 
separately).

TouchPanel uses a touch-
sensitive screen designed 
for use with your fingertip or 
a stylus. To select an item 
on the screen, press once 
on the item, using gentle 
pressure.

Radio interference
This is a Class A product. In a 
domestic environment, this product 
may cause radio interference, in which 
case the user may be required to take 
adequate measures.
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2. Using Screens and Menus
Everything you can do with TouchPanel involves using its system of Screens and Menus. This section explains what 
Screens and Menus are, what the various elements are and what they do, and explains how to use the Configuration 
menus and Pop up menu together.

2.1 About Screens
Screens provide a graphical user interface for controlling your lighting system on a day-to-day  
basis. From Screens you can select lighting scenes, raise or lower the lights, or select other Screens. Every item that 
appears on a Screen can be customized. To learn how to create and modify Screens, see section 8.

Title
This shows the name of 
the Screen. To learn how 
to change the title, see 
section 8.

Buttons
These are used to select  
scenes, fade the lights, 
control devices, or select 
other Screens. To learn how 
to configure buttons, see 
section 8.5 to 8.10.

Clock
A clock can be included  on 
any Screen. To learn how to 
add a clock, see section 8.5. 
To learn how to set the time, 
see section 16.

Label
A label can be included  
on any Screen. To learn 
how to add a label, see 
section 8.5.

Background
A picture or colour shown 
behind the buttons. To 
learn how to configure the 
background, see section 8.3.

Hotspot
An invisible button in the 
lower right corner of the 
screen. Press it to enter the 
Configuration menus. 
To learn how to use the 
Configuration menus, see 
sections 2.2 to 2.5.
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2.2 About Configuration menus and the Pop Up menu
These are text menus used to configure and customize TouchPanel, configure lighting scenes, configure Scheduled Events, 
and customize the look and content of Screens.

Title and advice Area
Shows the title of the current menu, 
or advice for you to follow.

Menu
A list of sub-menus and 
commands. Menu content varies 
according to mode of operation. For 
a list of all icons and their purpose, 
see the back cover of this guide. To 
learn about modes of operation, see 
section 3.2.

List
A collection of related items, 
such as Loads, Scenes, or 
Screens.

Back button
Click this button (or anywhere 
in the Title and advice area) to 
return to the previous menu.

Pop up menu
A row of icons at the bottom of 
the screen. It provides commands 
that can be used with items that 
are shown in the main part of the 
screen. For example, if you have a 
Scene on the screen, the Pop up 
menu provides commands that can 
be used with that Scene.
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1	
Press

2.3 Accessing Configuration menus

1
Press the Hotspot in the lower-right corner of the  
screen for at least four seconds.

2	
Type in the password and press

To learn about password protection, see 
Section 15.

When you have entered a valid password, features protected by the password can be used until the password expires. The 
password expires if you return to a Screen, and do not return to the Configuration menus within 20 seconds. After this 
time, if you want to access the Configuration menus, you must enter the password again. This ensures that TouchPanel’s 
Configuration menus are protected automatically from accidental or unauthorized access.

2.4 Exiting from Configuration menus

Press

The Main Menu will appear.

repeatedly until the required screen or menu appears. You may also need to exit from any configuration 
mode you are in, such as Move mode or Properties mode.

2
Wait 20 seconds. When this time has elapsed, the password will expire and TouchPanel is secure. You must type in the 
password again to access the Configuration menus.



Helvar 924 LCD TouchPanel: Installation and User Guide6 www.helvar.com   

2.5 Using Configuration menus and Pop Up menu
The Configuration menus and Pop up menu are used together to perform many different tasks. Normally you press an item 
to select it but, sometimes the Pop up menu is made available when an item can have an action performed on it.

To perform an action on an item, select the action from the Pop up menu, and then press the item on which you want 
to perform the action. Some Pop up menu commands work just once, but some remain active until you quit from them. 
For example, if you select the delete         command , you can continue to select and delete items until you quit from that 
command. The following example shows the delete command in use:

1
Press       to select the delete command.

This screen shows a list of Loads, which in this case are SCR 
Dimmer channels. The last is a missing load and is shown in 
GREY.

If only one Pop up menu icon is visible, you may be in 
a command already. Press that icon to quit from the 
command and display the Pop Up menu.

2
Select the load to delete. Only missing loads can be deleted. It 
will be highlighted in RED.

3 	
Press      to confirm the deletion. Notice that the delete icon 
remains visible in the corner of the screen. This indicates that 
the delete command is still active.

4	
If you wish, select another SCR Dimmer to delete it. When you 
have finished deleting items, press     to quit from the delete 
command.
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3. Switching ON for the first time
TouchPanel requires some configuration before it can be used. The configuration process is a once-only process that 
starts automatically when TouchPanel is switched on, unless the configuration process has been completed previously.

Once the mode of operation has been set, you can only change it by resetting TouchPanel to factory defaults. To 
learn how to do this, see section 14.

3.1 Setting Language, Mode, Date And Time

1. 	 Switch TouchPanel on and wait up to 30 seconds.

2. 	 The Language menu will appear.

3. 	 Select a language.

4. 		  to accept the language.

7.	 If not previously set, the Set Date And Time menu will appear.

8.		  and         to set the date and time.

9. 	         to accept the date and time.

10. 	The Default Screen will appear. TouchPanel is now ready for use.

5. 	� The Select Mode menu will appear. Press Master Panel, Toolbox 
Slave, Workshop Slave, or Designer Slave to set the mode of 
operation. To learn more about each mode, see section 3.2.

6.		  to accept the mode.

Once the mode of operation has been set, you can check the 
mode setting later by viewing the About screen. To learn more, 
see section 20.2.

TouchPanel can retain its configuration settings indefinitely. 
However, if TouchPanel remains without power for more than 
approximately two days then the date and time may need to be 
reset. To learn how to set the date and time, see section 16.
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3.2 Modes of Operation

Master Panel mode:
In Master Panel (MP) mode, TouchPanel can be independently configured and control all aspects of the 
lighting system. Only one TouchPanel is allowed in MP mode. DALI/Digidim and Imagine (S-DIM) devices 
are simultaneously supported in MP mode.

Toolbox Slave mode:
In Toolbox Slave mode, TouchPanel only functions as a DALI/Digidim control panel. Lighting  
system configuration is not possible. Screens and objects can be added and configured. Editing 
TouchPanel Schedules, Sequences and Cycles is also possible. Other device configuration must be done 
via Toolbox or in MP mode.

Workshop Slave mode:
In Workshop Slave mode, TouchPanel only functions as a scene recall panel. Lighting system 
configuration is not possible. Screens and objects can be added and configured. Editing TouchPanel 
Schedules, Sequences and Cycles is also possible. Other device configuration must be done via 
Workshop.

Designer Slave mode:
In Designer Slave mode, TouchPanel only acts in conjunction with physical or virtual button panels. 
Lighting system configuration is not possible. Screens and objects can be added and configured. Editing 
Local Schedules is also possible. Other device configuration must be done via Designer.
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4. Recommendations for configuring
Configuring TouchPanel allows you to customize its features to suit your needs. Configuring involves working with Loads, 
Groups, Scenes, and Screens. The number of items that you can configure depends on the mode of operation chosen for 
TouchPanel. To learn about mode of operation and how to set it, see section 3.2. The following table indicates the items 
that can be configured in each mode:

Recommended 
Configuration 
Sequence

1. Name each Group Yes Yes No No Give each Group a meaningful name.
To learn more, see section 5.2.

2. Assign Loads to 
Groups

Yes No No No Assign all loads to relevant Groups. To 
learn more, see section 5.6.

3. Edit Scenes Yes No No No Edit each scene as required.
To learn more, see section 6.1.

4. Edit Digidim Controls Yes No No Yes Assign all Controls to relevant Groups 
and functions to buttons.  To learn 
more, see section 7.

5. Define Screens Yes Yes Yes No Define Screens to provide all required 
user controls.
To learn more, see section 8.

6. Define Key Mappings No No No Yes Define Key mappings to provide all 
required user controls.
To learn more, see section 8.10.

7. Edit buttons in 
Screens

Yes Yes Yes Yes Assign functions to buttons.
To learn more, see section 8.8.

8. Add Scheduled 
Events

Yes Yes Yes Yes Add events that will automate 
TouchPanel.
To learn more, see section 9.2.

9. Add Sequences and 
Cycles

Yes Yes Yes No Link scenes so that they execute 
sequentially. To learn more, see 
sections 10.1 to 10.6.

10. Configure  
Remote Control

Yes Yes Yes Yes If the system includes a remote control, 
configure it now. To learn more, see 
section 11.
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5. Setting up Loads and Groups
In Master Panel mode TouchPanel detects the presence of loads automatically and can work with them immediately, but it 
is usually easier for you to work with loads once you have given them meaningful names, and organised them into groups. 
This chapter explains how to set up, name and group loads. 

5.1 About Groups
Groups provide a way to break the lighting system into convenient collections of loads and controls, making the lighting 
system easier to manage. By putting buttons and loads into the same Group, we can ensure that Scene recalls sent from 
TouchPanel buttons are only responded to by the loads in the same Group; and conversely, loads in other Groups will 
ignore commands for this Group.

You are not restricted by this structure though. You can configure each TouchPanel button to control loads in a particular 
Group, or send commands to the entire lighting system by using Broadcast commands. To learn more about Broadcast, 
see section 21.2.

Example:

TouchPanel:

Kitchen: Group 1

Diner: Group 2

L1
L2

L3

L4

Loads Groups
L1 Group 1
L2 Group 1 and Group 3
L3 Group 2 and Group 3
L4 Group 2

This example shows four Loads in three Groups. 

Group 1 contains L1 and L2, which are in the Kitchen and Breakfast Bar respectively; Group 2 contains L3 and L4, which 
are in the Breakfast Bar and Diner respectively; and Group 3 contains L2 and L3, which are in the Breakfast Bar. 

These Groupings allow you to control the lights in just the Kitchen, just the Diner, or just the Breakfast Bar. Of course, you 
can select a scene in Group 1 and another scene in Group 2, to set the lights in both Groups, and so on for Group 3.
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1. 	From		  Main Menu select the following:

2. 		  Edit Scenes.

3. 		  to display the Pop up menu.

4.		  and then   from the list choose the Group you want to rename.

5.		  and then type in a new name for the Group.

6.		  to save the changes.

5.2 Renaming a Group
It can be useful to rename each Group, for example, to indicate the room or area it represents.

5.3 Load Quantity Limits
TouchPanel can work with Imagine, and/or DALI/ Digidim loads. When in Master Panel mode, TouchPanel can work with 
up to 64 Imagine channels and/or 63 DALI/Digidim channels. DALI and Digidim loads are addressed automatically, so you 
do not need to set these addresses.

When using Imagine loads the addresses must be in the range 1 to 64. To learn how to set the address of an Imagine load, 
see the documentation accompanying it.

5.4 Identifying a Load
1. 	From	          Main Menu select the following:

2. 		  to display the Loads menu.

3. 		  to view the Pop up Menu.

4.		  to enter Identify mode

5. 	Select the Load to identify. The Load will toggle between Min and Max levels until you select a different Load, or you exit 
Identify mode.

6. 	Repeat step 5 to identify more Loads, or         to exit Identify mode
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5.6 Adding Imagine Loads
Imagine loads are discovered automatically by TouchPanel. However, if some have not yet been delivered to site, or are not 
yet connected, they can be added manually. This allows naming, grouping, and scene editing for these loads, in readiness 
for their connection.

1. 	From        Main Menu select the following:

2.		  to display a list of discovered Loads..

3.		  to view the Pop up Menu.

4.		  to add a load.

5.		  to edit the Load name.

6.		  to select the Groups to which the load will belong.

7. 		  to select Load type.

8.		  to select the address for the Load.

9.		  to select the number of channels of this load type to add.

10.		 to save the changes.

5.5 Renaming a Load
It can be useful to rename each load to indicate its purpose or location, and to make it easier to identify each load later.

1. 	From        Main Menu select the following:

2. 		  to display a list of discovered Loads.

3.		  to view the Pop up Menu.

4.		  and then select the load you want to rename.

5.	 and then type in a new name for the load.

6.	 to save the changes.
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5.7 Edit Load Properties
1.	 From        Main Menu select the following:

2.		  to display a list of discovered Loads.

3. 		  to view the Pop up Menu.

4. 		  to enter edit mode. The load level display shows the groups to which each load belongs.

5.	 Choose the load you want to edit.

6. 		  to edit the Load properties.

7. 		  to display the Select Groups menu.

8.�Tick the number of each Group to which you want this load to belong. If you want this load to be controlled only in 
Broadcast mode, then assign the load to no groups at all. To learn more about Broadcast, see section 21.2.

9.		  to select Load type.        

10.		 to save the changes.

5.8 Changing a Load Level manually
Levels are normally set by calling a scene that sets the required levels, but you can also set the level for
individual loads manually.

1. 	From        Main Menu select the following:

2. 		  to display a list of discovered Loads.

3.		  and    	    to raise or lower a load level, or press within the load to set its approximate level. 
	
The current level is shown in yellow, with a percentage 
value to the left of the load. You should see the load 
level in the system change immediately.  

For example, if the load is a dimmer driving some lamps, 
you should see the brightness of the lamps change 
as you change the load level.

The current level is normally shown in YELLOW. If the 
load is not present, the level is shown in GREY.
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5.9 Deleting a Missing Load
Levels are normally set by calling a scene that sets the required levels, but you can also set the level for
individual loads manually.

1. From        Main Menu select the following:

2.		  to display a list of discovered Loads.

3.		  to display the Pop Up Menu.

4.	�	  and then from the list, choose the load you want to delete. The load level will change to RED. 

5. Press        to confirm the deletion.

6.	Delete other loads if required, and then press       to leave Delete mode.
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6. Setting Up Scenes
A scene is an arrangement of lighting levels. When a scene command is directed at a Group, usually all loads in the Group 
will change their level accordingly. If a scene command is Broadcast, usually all loads in the system will change their level 
accordingly. It is possible for a load to ignore particular scenes, leaving its level unchanged even after receiving this scene 
command.

To learn more about Scenes, and how they work in the context of the lighting system, see section 21.3.

Example

In this example there are four loads, L1, L2, L3 and L4, with all levels set initially to 
100 %. L1 and L2 are added to Group 1, and L3 and L4 are added to Group 2.

By editing Group 1 Scene 1 (G1S1), the levels of L1 and L2 can be set (in this example 
to 75 % and 65 % respectively), independently of L3 and L4. By editing Group 2 Scene 
1, the levels of L3 and L4 can be set (in this example to 80 % and Ignore respectively), 
independently of L1 and L2. As mentioned earlier, setting L4 to Ignore in Scene 1, 
causes the level for L4 to remain unchanged whenever Scene 1 is recalled. 

Starting with all levels at 100 %, then when Group 1 Scene 1 (G1S1) is recalled, the 
levels of L1 and L2 are changed. Notice that L3 and L4 are not affected and therefore 
remain at 100 %.

Next, when Group 2 Scene 1 (G2S1) is recalled, the levels of L3 and L4 are set. Notice 
that L1 and L2 are not affected and therefore remain at 75 % and 65 % respectively. 

If we start again with all loads at 100 %, and this time recall Broadcast Scene 1, the 
end result will be the same.

All four loads with levels at 100 %.

After G1S1 has been recalled

After G1S1 and G2S1 have been 
recalled or after BS1 has been 
recalled.
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6.1 Setting Up Scenes
Before setting up Scenes, you should assign the Loads to Groups. To learn more about Groups, see section 5.

1. 	From        Main Menu select the following:

2. 		  to display the Edit Scenes menu.

3. 	Select the Group containing the loads you want to edit.

4.	 Select the scene to edit it.

5. 	Set the level for each load in the Scene by pressing in the loads bar, using        or       ,or pressing the level value box 
to toggle it between 100 % and Off.

6. 	 Select       or          to set a load to Enabled or Ignore.

7.		  to save the changes.
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7. DIGIDIM Controls
TouchPanel can recognise Digidim Controls that are present in the lighting system. View information about each control, 
find out if a control is missing, and to configure and rename controls.

7.1 Viewing information about a Digidim Control
1. 	From        Main Menu select the following:

2.		  to display the Controls menu.

3.		  to display the Pop Up Menu.

4.		  to enter Properties mode.

5.	 Select the Control for which you want to view information.

7.2 Identifying a Digidim Control

1. 	From          Main Menu select the following:

2.		  to display the Controls menu.

3. 		  to display the Pop Up Menu.

4.		  to enter Identify mode.

5. �	Select the Control to identify. An LED on the physical Control will flash until you select a  
	different Control, or you exit Identify mode.

6. 	Repeat step 5 to identify more Loads, or         to exit Identify mode

7.3 Editing Digidim Control Properties
1. 	From          Main Menu select the following:

2.		  to display the Controls menu.

3.		  to display the Pop Up Menu.

4.		  to enter Properties mode.

5.	 Select the Control for which you want to edit the properties.

6.		  and then type in a new name for the Control.7. 	      

444 Mini Input Unit does not have an LED.

To learn how to refresh the Controls list, see section 13.1.
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7.4 Editing Digidim Control Subdevice Properties (buttons, infrared, 
analogue inputs and digital inputs)

1. From	          Main Menu select the following:

2. 		  to display the Controls menu.

3. 	Select the Control for which you want to edit the subdevice properties.

4. 	Select a button or input to edit.

5. 		  and then select a group to which this subdevice will belong.

6. 		  or	 to toggle the input between analogue or linear mode (Analogue Input Unit 942 only).

7.		  and         then to set the Rising Threshold percentage (for Analogue Input Unit 942 only).

8.		  and         then to set the Falling Threshold percentage (for Analogue Input Unit 942 only).

9.		  to modify the slider input (for Analogue Input Unit 942 only). See section 25.5.

7.		  and then select a Group to which the control will belong.

8.	 to enable or disable infrared.

9           ,         or       and then select the type for each input (for input units only). You may change an input type from  
Switch Edge      , Switch Button        , Analogue Edge       , or Analogue Slider           depending on the input unit selected.

10. 	 and then select a PIR mode (for Multisensor 312 only).

11.� 	 to enable or disable the Constant Light feature (for Multisensor 312 only). When enabled, constant light scenes 
become available (       ).

12.	 to display the Advanced Settings menu. Choose from the following control-specific settings:

  * 	 to lock or unlock the Control. Locking a Control prevents local scene stores and changes.

  *	� to set the Scene Store Delay time. Scene Store Delay determines the length of time a scene button must be 
pressed before the scene is stored.

  * 	 to enable or disable the infrared 2-button modifier.

  * 	 to switch the infrared filter to accept only broadcast IR, or also to accept a selected IR  
	 channel.

  * 	 to select the scenes that will, when recalled, disable PIR (for Multisensor 312 only).

13. 	 to save the changes to Advanced Settings and         to save the changes.
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10.		 to change the button function. Choose one of the following settings:

   *		 to allow the button to call a scene, then choose a scene to call.

   * 	 or        to allow the button to fade up/down the channels in a particular Group.*1

   * 	� to choose other functions for this button. To learn more about the devices that these functions control, contact 
your TouchPanel supplier.

   *		 to set button to Not Used. The button will have no function

11.	��	� to �set a fade time. This is the time taken to fade the lights to the selected scene. 
		  Only applies to scene recall functions in Digidim modes.

12.		 to display the Advanced Options menu. Choose one of the following settings:

   *		� to select a scene to call or store. If the button is pressed briefly then the selected scene will be recalled. If the 
button is pressed for longer than the Scene Store Delay time then the current levels for the loads controlled by the 
button/input will be stored as the selected scene. To learn more about Scene Store Delay, see section 7.3.12.

   *		� select a level with modifier. If the button is pressed briefly then the selected level will be recalled. If the button is 
pressed for longer then the current levels for the loads controlled by the button/input will be modified.

   * 	� to select a toggle feature for the button. Each time the button is pressed its behaviour will toggle between the two 
selected settings. E.g. Max Level/Off will toggle between max level and off. Touch/last-level will toggle between 
the last level and off, or for longer presses  will cause fade up or down.

   * 	 to select modifiers with turn on and off for the button.

   * �	� to select enablements for the button. These settings allow the button to enable or disable certain features of the 
Control Devices.

   *		 to select a specific level for the loads in the group associated with this button.

13. 	 to save the changes.

	*1 In Designer, mode key mappings are used. See section 6.2
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7.6 Editing Digidim Control Subdevice Properties (Multisensor 312 PIR)
The PIR sensor is configured in the same way as a button, but with the addition of special features for Multisensor 312. To 
learn how to configure the PIR sensor, see section 7.3.10. To learn about PIR special features, see below.

The constant light subdevice, if enabled, is presented as a constant light in and constant light out. The constant light in subdevice 
shares its group with the PIR sensor, so changing the group of the PIR will also change the constant light in, and vice versa.

The constant light in sub-device should be the same group as other button controls. The constant light out subdevice should 
have its group set to contain the loads to be controlled. The constant light module of the multisensor will then listen for 
requests in the in-group, and use this information to decide how to control the loads of the out-group.

7.5 Editing Digidim Control Subdevice Properties (Sliders)

To store a constant light level into a scene, set the light level to the desired level, using any suitable method 
(adjust the light from TouchPanel, a remote control, another control, or by adjusting the curtains/blinds in the 
room). Once the desired light level has been achieved, perform a scene store (for example, by holding the relevant 
scene button in for more than the default scene store time). Once stored, recalling this scene will cause the lights 
to be adjusted automatically as the daylight varies, thus maintaining the stored light level. 

To enable or disable the constant light feature, see section 7.3.11.

1. From         Main Menu select the following: 

2.	 to display the Controls menu. 

3. Select the Control for which you want to edit the subdevice properties.

4. Select a slider to edit. (There is only one slider for 110 slider devices.)

5.	 and then select a group to which this slider will belong.

6.	 to change the button function. Choose one of the following settings:

  *	 to allow the slider to issue levels to minimum, but not to off.

  *	 to low the slider to issue levels down to off.

  *	 to set the slider to Not Used. The slider will have no function.

7.	� or        to set the slider to linear or logarithmic curve mode. Logarithmic mode is best for DALI ballasts and 
dimmers. Linear mode is best for Imagine dimmers.  

8.	 to save changes.

1.  From        Main Menu select the following: 

2.	 to display the Controls menu. 

3. Select Control from which you want to edit subdevice properties and select a button to edit.

4.	 and then select a group to which the PIR will belong.
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7.7 Editing Digidim Control Subdevice Properties (Rotary 100)
1. From         Main Menu select the following:

2.	 to display the Controls menu.

3. Select the control device you want to edit.

4. 	 to change the rotary switch settings.

5.	 and then select a group to which the rotary subdevice will belong.

6.	� to change the rotary function. The rotary subdevice can be enabled or disabled but its function cannot be changed. 
The push operation of the rotary subdevice always issues a 	 last level/off command. Choose one of the following 
settings:

  *	 to enable the rotary switch.
  * 	 to disable the rotary switch.

7. 	 to save the changes.

5. 	 and then one of the following PIR modes: 

  * 	 to set the On Timeout.
  *	 to set the Minimum Hold Timeout.
  * 	 to set the Exit Delay time.
 
6. 	 to change the button function. Choose one of the following settings:

  *	 to allow the button to call a scene, then choose a scene to call.
  *	 to allow the button to fade up the channels in a particular Group. Choose a Group  
	 containing the channels you want this button to fade up.
  * 	 to allow the button to fade down the channels in a particular Group. Choose a Group  
	 containing the channels you want this button to fade down.
  *	 to choose other functions for this button. To learn more about the devices that these  
	 functions control, contact your TouchPanel supplier.
  *	 to set button to Not Used. The button will have no function.

7.	 to display the Advanced Options menu. To learn more about the Advanced Options, see
	 section 7.4.12.

8.	 to save the changes.
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7.8 Deleting a missing Digidim control
1. From          Main Menu select the following:

2.	 to display the Controls menu.

3.	 to display the Pop Up menu.

4.	� to enter Delete mode, and then from the list choose the Control you want to delete. The Control will be shown in 
RED. Press         to confirm the deletion.

5. Delete other Controls if required, and then        to leave Delete mode.

7.8 Digidim Control symbols

100 Rotary Switch

110 Single Slider Panel

111 Dual Slider Panel

121 Panel

122 Fader Panel

124 Panel

125 Panel

126 Panel

170 Infrared Receiver

312 Multisensor

942 Analogue Input Unit

440 Input Unit

444 Mini Input Unit

924 TouchPanel

930 Panel

935 Panel

939 Panel

A control that is not recognised or yet supported by 
TouchPanel.

This icon appears beside an item that is no  
longer present.

This icon appears beside an item that is currently being 
checked to see if it is still present.

Only Controls that are missing (i.e. no longer present in the system) can be deleted. Missing Controls are 
shown with     beside them.

6
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8. Setting Up Screens
A Screen is a collection of buttons, shapes, clock, captions and 
background picture or colour, customized to suit your needs. Screen 
customization allows you add new buttons, arrange them however you 
wish, assign actions to them, and even use Themes to change the way 
they look.

In typical use, TouchPanel can store around 500 Screens. When 
TouchPanel is switched on and configured, it always displays the Default 
Screen (section 3.1). It makes sense therefore, for this Screen to include 
the most commonly-used options.

8.1 Designing a Screen Hierarchy
A large space, such as a nightclub, may be divided into several areas that require separate lighting control. One way to 
make control easier is by using a separate Screen for each area, with each Screen allowing selection of scenes for that 
area only. In this way, you can use a single TouchPanel to control the lighting of the whole nightclub.

The example below shows a simple collection of Screens for a nightclub:
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Each box represents a Screen, and each line indicates a link to another Screen. The Default Screen provides common 
scenes, such as scenes to switch all lights on or off, plus a link to Areas, which contains links to other Screens relating to 
each part of the nightclub.

This hierarchical arrangement of Screens can be extended or changed easily. For example, if you have added a stage to 
the nightclub, it is simple to add a Stage entry to the Areas Screen, which links to a new Screen containing stage lighting 
controls.

Buttons can be used to provide navigation from one Screen to another. A Screen can also include a timeout, so that it 
remains visible for a limited time after the last press, after which it calls a different specified Screen (called a Return 
Screen) automatically.

To learn how to configure a button for navigation, see section 8.8.
To learn how to configure a Screen to use a Return Screen, see section 8.3.

8.2 Adding a Screen
1. From         Main Menu select the following:

2.	 to display the Screens menu.

3.	 then         to add a new Screen. The properties for this screen will be displayed.

4.	 to display the Layout Menu. These settings allow you decide what buttons will be on the Screen when it is created.

5. Choose the number of Scene Buttons to include. Decide whether there will be Modifier Buttons, an Off Button, a Clock, 
or Next/Previous screen buttons. The chosen controls will be arranged neatly for you automatically when the Screen is 
created. The exact number of buttons is restricted to that which can be arranged evenly on the screen, but you can 		
remove surplus buttons or add more buttons later.

6.	 to choose the Group (or          to choose the Scene Block Address in Designer mode) to which the buttons on this 
Screen will belong. 

		  Set Group/Address/Scene Block to avoid having to set each key.

7.	 and choose a Theme for the Screen.

8. Other settings are available by pressing         to display the Advanced Setting screen, but as these settings are usually 
made later, they are explained in their own section. To learn more about editing Screen settings, see section 8.3.

9.	 to add the Screen with the chosen settings.
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8.3 Editing Screen properties
Screen properties allow you to change the Layout and Theme or background of a Screen, and change the Group to which 
its buttons belong.

1. From          Main Menu select the following:

2. 	 to display the Screens menu.

3.	 to display the Pop up menu.

4. 	 to enter Properties mode.

5.  Navigate to the required Screen in the list, and then press the Screen to edit it. Choose one of the following settings:

 
 *	� and choose the Group (or  to choose the Scene Block Address in Designer Mode) to which the buttons of this 

Screen will belong.

  *	 and choose a Theme for the Screen.

6.	 to display the Advanced Settings screen. Choose one of the following settings:

  *	 to change the Screen Title. It is useful to give each Screen a friendly or descriptive title.

  *	 display or hide the Screen Title.

  *	� to enable password protection for this Screen, or         to disable it. When a password has been set and protection 
has been enabled, this Screen can only be displayed if the correct password is entered. This is a useful way to 
limit access to TouchPanel in public access or sensitive locations.

  *	� to choose a background picture or solid colour.       or       to change the change the picture. To choose a 
background colour, press        while in the Set Theme screen, and then choose a colour. This will override the 
background image of the Theme.

  *	� to enable or disable Timeout. Each Screen can have a Return Screen Timeout that limits the length of time it will 
remain on the screen before switching automatically to a different Screen. This can be used to ensure that each 
new user arriving at TouchPanel sees a familiar screen.      

  *	� to set a Return Screen Timeout time.

  *	� to choose a Return Screen: If you have enabled Timeout, then you must choose a Screen to switch to after the 
Timeout period. Normally this is Screen 1.

7. 	 to save the changes.
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8.4 Deleting a Screen
1. From           Main Menu select the following:

2. 	 to display the Screens menu.

3.	 to display the Pop Up menu.

4.	 to enter Delete mode, 

5.  Select the screen to be deleted.

6.	 to delete the highlighted screen

7. Repeat steps 5 and 6 to delete more Screens, or        to exit Delete mode.

8.5 Adding a Control
Buttons can be used to control the lighting system, clocks can be used to display the time or date. Shapes can be used to 
create a diagrammatic floor plan onto which buttons can be placed to control lights or change Screen, and labels can be 
used to provide additional information.

1. From          Main Menu select the following:

2. 	 to display the Screens menu.

3. Select the screen to be edited

4.	 to display the Pop Up menu.

5.	 to enter Add mode. A menu of control types will appear. 

6.	� to add a button,         to add a clock,         to add a shape, or       to add a label. The properties for the button, clock, 
shape or label will be displayed.

7. Edit the properties as required. To learn more about editing control properties, see section 8.8.

8.	 to save the changes and add the control.

At least one Screen must be present at all times. If you delete the only remaining Screen then a new Default 
Screen will be added automatically.

If you delete a Screen that another Screen is using as a Return Screen, then the first listed Screen will be 
used as the Return Screen.
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8.6 Moving Controls
The controls on a Screen can be arranged to suit your needs. For example, it is usual to arrange scene buttons into one or 
more columns; arrange the modifier buttons to one side of the screen, one above the other, and to position the Off button 
near the bottom-right of the screen.

1. From         Main Menu, press          to display the Screens menu:

2. Navigate to the required Screen in the list, and then press the Screen to edit it.     

3.	 to display the Pop up menu, if necessary.

4.	 to enter Move mode.

5. �Select the control you want to move. Its border and screen location will be shown in  yellow. If you press the wrong 
control, press         and then press the control you wanted to move.

6. Press anywhere on the screen to select the new location for the control.

7.	 ,        ,        and        to position the control accurately.

8.	 to enter Resize mode, if this is available for the type of control being moved.   

9.	 saves the changes. 	

8.7 Resizing Buttons and Shapes
The controls on a Screen can be arranged to suit your needs. For example, it is usual to arrange scene buttons into one or 
more columns; arrange the modifier buttons to one side of the screen, one above the other, and to position the Off button 
near the bottom-right of the screen.

1. From         Main Menu, press          to display the Screens menu:

2. Navigate to the required Screen in the list, and then press the Screen to edit it.     

3.	 to display the Pop up menu, if necessary.

4.	 to enter Resize mode.

5. �Select the control you want to resize. Its border, width and height will be shown in yellow. If you press the wrong control, 
press         and then press the control you wanted to move.

6. ���Tap on the screen to move the controls nearest edge or corner to that point, or for fine adjustments select       ,         ,      
or          to resize the control.

7.	 to enter Move mode.      

8.	 to save the changes.

Buttons can only be narrowed or widened. If the button caption is longer than the width of the 
button, then the button name will be truncated from the left. 
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8.8 Editing Control properties
1. From          Main Menu select the following:

2.	 to display the Screens menu.

3. Select the Screen to edit.

4.	 to display the Pop up menu, if necessary.

5.	 to enter Properties mode.

6. �Press the control that you want to edit. The properties of each control type you can edit are explained in the following 
steps:

Button:

7. 	 to edit the button caption. Giving a button a new caption allows the user to see exactly what the button does.

8.	� and choose the Group (or            to choose the Address Properties) to which the buttons of this control will belong. 
This is not available for Change Screen function.

9.	 to change the button function. Choose one of the following options:

   * 	� to allow the button to call a scene. If the chosen scene is being used in a Sequence or Cycle then pressing this 
button will cause the Sequence or Cycle to execute. To learn about Sequences and Cycles (see section 9.)

   * 	 to allow the button to fade up the channels in a particular Group, Channel or Scene Block.

   *	 to allow the button to fade down the channels in a particular Group, Channel or Scene Block.

   *	 to allow the button to link to a Screen.

   *	� to choose other functions for this button. To learn more about the devices that these functions control, contact 
your TouchPanel supplier.

   *	 to set button to Not Used. The button will be displayed but have no function.

10. 	� to set a fade time. This is the time taken to fade the lights to the selected scene. Only applies to scene recall 
functions in Digidim modes.

The exact Fade Time depends on the type of load to which it is sent. For Imagine loads the Fade Time is exact, but 
for DALI and DIGIDIM loads it is rounded down to one of the following Fade Times:  0.5, 0.7, 1.0, 1.4, 2.0, 2.8, 4.0, 
5.6, 8.0, 11, 16, 23, 32, 45, 64, and 90 seconds.
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11.	 to display the customize Button Appearance Settings screen. Choose one of the following  
	 options:

   *	 to choose a style for the button. This will override the button style from the Theme.

   *	 to adjust the text justification of the button (clock and label controls do not allow this).

   *	 to choose a colour for the button caption.

Clock:

12.	 to choose the clock format. The clock can show the time and/or date in various formats.

13.	 to choose the clock colour (digital clock or date only).

14.	 to choose the clock hands colour (analogue clock only).

15.	 to choose the clock face colour (analogue clock only).

Label:

16.	 to edit the text of the label.

17. 	 to set the colour of the label text.

18.	 to save the changes.

8.9 Deleting a Control
1. From          Main Menu select the following:

2.	 to display the Screens menu.

3.  Navigate to the required Screen in the list, and then press the Screen to edit it.

4.	 to display the Pop up menu, if necessary.

5.	 to enter Delete mode.

6. Press the control that you want to delete. It will be highlighted.

7.	 to delete the highlighted control.
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8.10 Mapping Keys
	      �It is possible to map the TouchPanel addresses and keys to mirror the Designer software to emulate key 

presses. Please see RS232 AV Interface to 910/920 Router User Guide (D004457) for further information.

	      �Map the addresses via the Screens menu as opposed to at button level.  
This is because all address edits made at screen level will apply to the lower button level – meaning you will 
only have to set the address once for all TouchPanel buttons. See 8.3 for further information.

To map the addresses:

1.  From          Main Menu select the following:

2.	 to select Screens Menu.

3.	 to display Pop Up Menu.

4.	 to enter Properties mode. Select the screen for which you want to view information.

5.	 to select Group Address block.

6.	 to select your chosen address.     

7.	 to save the changes.

All TouchPanel buttons will now have the same address for the selected scene.

To map individual keys:

8. From          Main Menu select the following:

9.	 to display Pop Up Menu.

10.	 to enter Properties Mode. 

11. Select the button you wish to change the key settings.

12.	 to change the Button function.

13.	 to select the individual key number.         

14.	 to save the changes.
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9. Automating the TouchPanel
TouchPanel can automate the lighting by recalling scenes or linking to Screens at regular daily or weekly intervals. It does 
this by using Scheduled Events. Here are some examples of common ways you can use Scheduled Events:

Calling a scene at a specific day and time
Calling a scene at a specific time is the most commonly used Scheduled Event, as it allows you to automate lighting 
changes to suit your daily/weekly routines. For example, in an office, you may want the lighting to switch on fully during 
normal working hours, from Monday to Friday, and to switch to an energy-saving lower level outside those hours. Two 
Scheduled Events can achieve this. At home, you may like certain lighting conditions when you arrive home each day. 
Again, this can be achieved with Scheduled Events. Another way to use Scheduled Events is for security purposes: You can 
change the lighting at specific times to give the impression that you are at home. 

Switching to a different Screen at a specific day and time
If there is a different Screen for day and night, you can create a Scheduled Event so that TouchPanel switches from the 
daytime Screen to the night-time Screen at a convenient time every evening, and switches back to the daytime Screen 
every morning. Specifying days of the week, you can have an event occur on the days you want, such as weekend-only, 
every day, or working day only. Therefore, you don’t have to find the right Screen for different times of the day - TouchPanel 
does this for you.

9.1 Enabling and Disabling Scheduler
Disabling Scheduler prevents scheduled events from executing. This is a useful way to control scheduled events without 
resorting to deleting or editing them.

1. From         Main Menu select the following:

2.	 to display the Options menu.

3. 	 to enable or disable Scheduler.

9.2 Adding a Scheduled Event
1. From         Main Menu select the following:

2. 	 to display the Scheduled Events menu.

3.	 to display the Pop up menu.

4. 	 to add a Scheduled Event.

5. �You may edit the properties now or later. To learn about the properties and how to edit them, 	see section 9.3.

6. 	 to save the Scheduled Event.
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9.4 Deleting a Scheduled Event
1. From         Main Menu select the following:

2.	 to display the Scheduled Events menu.

3.	 to display the Pop up menu.

4.	 to enter Delete mode.

5. Select the Scheduled event to delete. It will be highlighted.

6.	 to save the Scheduled Event.

9.3 Editing a Scheduled Event
1. From           Main Menu select the following: 

2.	 to display the Scheduled Events menu.

3. Select the Scheduled Event to edit.

4.	 to set the trigger time (only available for Scene Recall function). Choose one of the following settings:

   *	 to set a time.
   *	 to use the dawn time, then adjust the time relative to dawn.
   *	 to use the dusk time, then adjust the time relative to dusk.

5.	 to choose the days of the week.

6.	� to edit the Scheduled Event name. Giving the Scheduled Event a new name makes it easier to identify among other 
Scheduled Events. If you clear the name completely and save the change, theScheduled Event will return to its 
default name.

7. 	 to choose a Group or Scene Block. Not available for Change Screen function.

8. 	 to change the Scheduled Event function. Choose one of the following settings:

   *	 to allow the Scheduled Event to call a scene. Choose a scene.
   *	� to allow the Scheduled Event to link to a Screen. This is a useful way to switch TouchPanels display between 

daytime and evening Screens automatically.
   *	� to choose other functions for this Scheduled Event. To learn more about the devices that these functions control, 

contact your TouchPanel supplier.
   * 	� to set the Scheduled Event to Not Used. This is a useful way to remove a Scheduled Event from use without the 

need to delete it.

9.	 to set a Fade Time. Only available for Scene Recall function.

10.	 to save the changes.
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10. Automating TouchPanel with Sequences and Cycles
Note: Unavailable with Designer Slave Mode
A Sequence allows you to execute a range of scenes automatically, by making connections between them called Links. 
Each Link defines how long the scene associated with it will remain in use before the next scene is executed, and the fade 
time that will be used for the transition. A Cycle is a Sequence that repeats indefinitely or until it is interrupted.

Starting and Stopping Sequences and Cycles
•	 To execute a Sequence or Cycle, recall any scene that is included in it. Once started, a Sequence or Cycle can be 

interrupted at any time by selecting a scene that is not part of it (but within the same Scene Block). 
•	 To start a Sequence or Cycle automatically, use a Scheduled Event to recall any scene used in the Sequence or Cycle.
•	 To stop a Sequence or Cycle automatically, use a Scheduled Event that recalls a scene not included in the Sequence or Cycle.
•	 The Sequence or Cycle will begin with the called scene, skipping the preceding scenes, and will continue the remainder 

of the Sequence or Cycle.

To learn about assigning a scene to a button, see section 8.8.
To learn about creating a Scheduled Event, see section 9.2.
A Sequence or Cycle can be started by recalling any scene within it, with execution commencing from the recalled 
scene. For example, if a Cycle includes scenes 5, 4, 3 and 2, when scene 4 is recalled, the Cycle will start with 
scene 4, and continue to scenes 3 and 2, before returning to scene 5 when the Cycle repeats.
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10.2 Adding a Sequence or Cycle
A Scene can only be used once in a Sequence or Cycle, and must be selected from within a single Group (or Broadcast). 
This means that a Sequence or Cycle may include up to 16 Scenes.

1. From         Main Menu select the following:

2.	 to display the Sequences and Cycles menu.

3.	 to display the Pop up menu.

4.	 to enter Add mode.

5.	 to add a new Sequence, or           to add a new Cycle. This creates the first Link of the Sequence or Cycle.

6.	 to select a Group. You can only do this when a Sequence or Cycle is first added.

7.	 to select a scene within the selected Group.

8. �You may edit the other properties of the Sequence or Cycle now or later. To learn about the properties and how to edit 
them, see section 10.3.

9.	 to toggle between adding another Link after this one, or completing the Sequence or Cycle.

10.	� to save the link. If adding is complete then you will be returned to Sequence or Cycle. If you are adding more links 
then the new link will be shown.

10.1 Sequences and Cycles Quick Reference
The icons shown below are used when editing a Sequence or Cycle. They help to identify the start, middle and end of a 
Sequence.

The first Link in a Sequence.

A Link in the middle of a Sequence, or any Link in a Cycle.

The last Link in a Sequence.
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10.3 Editing a Sequence or Cycle
1. From         Main Menu select the following:

2.	 to display the Sequences and Cycles menu. Select the Sequence or Cycle to edit.

3. Select a Link to edit.

4.	 to rename the Link. The first Link name is also used as the name for Sequence or Cycle.

5.	� to set the Link Duration. This value determines how long this scene will remain in use until the next scene in the 
Sequence or Cycle is selected. This setting is not available for the last Link in a Sequence because the scene 
remains selected when the Sequence ends.

6.	� to select a Fade Time to be used when the selected scene is called by another Link. This is not available in 
Imagine Slave mode, or for the first scene in a Sequence.      

7.	 to save the changes.

When you create a Link, Fade Time defaults to Link Duration. This means that if Link Duration is 5 seconds, 
then Fade Time will also be 5 seconds. You can make these values different if you wish.

The example below shows the relationship between Fade Time and Link Duration, in a Link between Scene 1 and Scene 2 
in a given Group.

In this example, the levels start at 
50 %, and Scene 1 sets the levels 
to 75 %. Fade Time is 20 seconds 
and Link Duration is 30 seconds.

Link Duration
Level
75 %

25 %

Fade Time

Time
20 sec 30 sec

Scene 1
recalled

Scene 1 levels
reached

Scene 2 
recalled

When Scene 1 is recalled, Fade 
Time and Link Duration begin. 
The relevant light levels fade for 
20 seconds, changing from their 
starting level to 75 %. The levels 
then remain the same until the 
end of Link Duration, when Scene 
2 is recalled.

A simple lighting effect can 
be achieved by setting Fade 
Time and Link Duration the 
same, causing the lights to fade 
continuously from scene to scene.
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10.5 Removing a Link from a Sequence or Cycle
1. From          Main Menu select the following:

2. 	 to display the Sequences and Cycles menu.

3.  Select the Sequence or Cycle from which you want to remove a Link.

4.	 to display the Pop up menu.

5. 	 to enter Delete mode.

6.  Select the Link to delete. It will be highlighted

7.	 to delete the highlighted Link.

10.4 Adding a Link to a Sequence or Cycle
1. From         Main Menu select the following:

2. 	 to display the Sequences and Cycles menu. Select the Sequence or Cycle you want to add a Link to.

3. �Select the Link that you want to be executed before the Link you are about to add. The existing Link will be opened for 
editing.

4.	 then        to add a new link.

5.	 to select a Scene for this new link.

6. You may edit the properties now or later. To learn about the properties and how to edit them, see section 10.3.

7. 	� to save the link. If adding is complete then you will be returned to Sequence or Cycle. If you are adding more links 
then the new link will be shown.

10.6 Deleting a Sequence or Cycle
1. From          Main Menu select the following:

2.	 to display the Sequences and Cycles menu.

3.	 to display the Pop up menu.

4.	 to enter Delete mode.

5. Select the Sequence or Cycle to delete. It will be highlighted.

6.	 to delete the highlighted Sequence or Cycle.
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11. Configuring a Remote Control
TouchPanel can be controlled (though not configured) via an infrared remote control. You can use Helvar Remote Control 
303 (shown) or a compatible “learning” unit that uses the Philips RC5 standard infrared protocol.

When you create a Link, Fade Time defaults to Link Duration. This means that if Link Duration is 5 seconds, then 
Fade Time will also be 5 seconds. You can make these values different if you wish.

11.1 Configuring a Remote Control
1. From          Main Menu select the following:

2.	 to display the Options menu.

3.	� to display a list of remote controls for which TouchPanel has been configured. Currently only the Helvar remote 
Control Handset, or a learning remote control can be used.

4. �Choose the remote control for which you want to edit the settings. A list of buttons will be displayed. Each button in the 
list corresponds to a button on the remote control. The first four buttons are scene buttons 1 to 4; the fifth button is the 
Off button; the sixth and seventh buttons are modifier up and down buttons.

5. Select the button you want to configure.

6.	 to edit the button caption. The caption is only visible when configuring a remote control.

7.	 to select the Group (or         to choose Scene Block Address) to which the buttons of this control will belong.

8.	 to change the button function.

9.	 to save the changes.

Modify Down
Adjusts light levels 

downward.

Modify Up
Adjusts light levels upward.

Scene Selector Buttons
Selects a scene.

Off Button
Switches the lights off.
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11.2 Renaming a Remote Control
1. From          Main Menu select the following:

2. 	 to display the Options menu.

3. 	 to display the Remote Control menu.

4. 	 to view the Pop Up menu.

5. 	 and then select the remote control you want to rename.

6. 	 and then type in a new name for the remote control.

7. 	 to save the changes.

11.3 Grouping the buttons of a remote control
1. From          Main Menu select the following:

2.	 to display the Options menu.

3.	 to display the Remote Control menu.

4.	 to display the Pop up menu.

5.	 and then from the list choose the remote control whose buttons you want to place in a Group or Scene Block.

6.	 to display the Select Groups menu, or          to display the Scene Blocks menu.

7.  Select the Group or Scene Block.

8.	 to save the changes.
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12. Backing Up And Restoring
All information stored in TouchPanel can be backed up to a computer, via a USB connection. Backed up information can 
also be restored, to the same TouchPanel or others, by the same means.

To use TouchPanel Backup you will need a computer with a USB port to connect the computer to TouchPanel. A suitable 
USB cable is included with TouchPanel.

Backup and restore is available if your TouchPanel is using software version 3.5.1 or later. You can check the 
version of software via the About screen. To learn more, see section 20.2.

12.1 Preparing your computer for use with TouchPanel Backup Software
1. Install the software from the CD supplied with your TouchPanel.

2. Before connecting the USB cable between the computer and TouchPanel:
	 •	 If the computer is a laptop or notebook, it must be removed from any docking station
	 •	 Remove any USB port expanders
	 •	 Remove the computer from any attached network connection

3. Power up the TouchPanel and wait for the start screen to be replaced by the initial user screen.

4. �Connect the USB cable between the computer and TouchPanel as detailed in step 12.2. Follow the instructions that 
appear on the computer screen. 

	� Note: the warning about Microsoft’s own drivers not being verified compatible with Windows itself is to be 
expected, and can be ignored by selecting ‘Continue Anyway’.

5.� �Once the device driver installation has been successfully completed, the computer is ready for use with the TouchPanel 
backup software.
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12.2 Connecting a computer to the USB port

Each time TouchPanel is reconnected to your 
computer it will take approximately ten seconds 
for the computer to acknowledge the connection.

12.3 Backing up TouchPanel

If your computer is not yet connected to TouchPanel via USB, connect it now.

1.	 From the Start menu or desktop shortcut, launch TouchPanel Backup.

2.	 Wait for TouchPanel Backup to establish communication with TouchPanel.

3.	 Press the Backup button:

4.	 Choose a folder to which the backup will be written, and then press the OK button.

5.	 Press the Backup button to start the backup. Section 10.4 shows the meaning of the status graphics during backup 
and restore.

6.	 Press the Abort button at any time to stop the backup process.

Before connecting the USB cable between the computer and TouchPanel:
 •  If the computer is a laptop or notebook, it must be removed from any docking station 
 •  Remove any USB port expanders
 •  Remove the computer from any attached network connection

2.

3.

4.

1.	 Ensure the software has been installed (see step 12.1)

2.	 Insert a flat bladed screwdriver into one of the side 
recesses of TouchPanel, and then twist the screwdriver 
gently to lever off the bezel. 

3.	 With the bezel loosened, remove Panel by hand.

4.	 Use the USB cable included with TouchPanel to 
connect your computer to TouchPanel.
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12.4 Restoring TouchPanel
It is usual for each TouchPanel in a lighting system to have different content. For this reason, each backup also records the 
serial number of the TouchPanel from which it has been made. 

If you attempt to restore the backup to a different TouchPanel, you will be warned about the mismatched serial numbers as 
a precaution, though you may continue with the restore. This allows you to configure one TouchPanel and use TouchPanel 
Backup to copy the content to other TouchPanels, or to configure a replacement TouchPanel.

Restoring a backup will cause all existing TouchPanel content to be erased.

1.	 If your computer is not yet connected to TouchPanel via USB, connect it now.

2.	 From the Start menu or desktop shortcut, launch TouchPanel Backup.

3.	 Wait for TouchPanel Backup to establish communication with TouchPanel.

4.	 Press the Restore button.

5.	 Choose a folder to restore, and then press the OK button.

6.	 Press the Restore button to start the restore.

7.	 TouchPanels Flash memory will be erased to make room for the restored content.

8.	 TouchPanel content will now be restored. When completed, TouchPanel will display the default screen.To learn about 
the default screen, see section 8. Section 10.4 shows the meaning of the status graphics during backup and restore.

9.	 Press the Abort button at any time to stop the restore process.

DALI control and load settings will not be restored. Backup and Restore therefore can not be used 
to clone Dali devices and restore the settings to devices on anther panel.

Do not delete the backup file until you are certain that TouchPanel is working correctly afer the
backup has been restored.

Before connecting the USB cable between the computer and TouchPanel:
 •  If the computer is a laptop or notebook, it must be removed from any docking station 
 •  Remove any USB port expanders
 •  Remove the computer from any attached network connection
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12.5 Backup and Restore Status
In TouchPanel Backup the following graphics indicate the status of the connection and communication with TouchPanel.

The USB cable is not connected between the computer and 
TouchPanel.

The USB cable has been connected between the computer and 
TouchPanel, but TouchPanel Backup has not yet established 
communication with TouchPanel.

The USB cable has been connected between the computer and 
TouchPanel, and TouchPanel Backup has established communication 
with TouchPanel.

TouchPanel Backup is backing up picture files to 
the computer.

TouchPanel Backup is backing up a settings file to 
the computer.

TouchPanel Backup is erasing the flash memory in TouchPanel during the
Restore process.

TouchPanel Backup is restoring picture files to 
TouchPanel.

TouchPanel Backup is restoring a settings file to 
TouchPanel.
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13. Refreshing and discovering devices
Refresh may be necessary if Digidim or DALI devices are added or removed without re-powering TouchPanel. You can 
do this by using the Refresh Devices feature. TouchPanel looks for new and existing devices, and then updates the list of 
devices that you can see in the Loads and Controls menus. If it cannot find a device (such as when a device is switched off 
or removed), then those devices will be listed in GREY in the Loads menu, or with “!” in the Controls menu. These can be 
deleted if required.

To learn how to delete a device, see section 5.8 (loads) or 7.9 (controls).

13.1 Refresh devices manually
1. From          Main Menu select the following:

2.	 to display the Options menu.

3.	 to display the More Options menu.

4.	 to display the Device Refresh screen.

5.	 to start the device refresh.

6. A summary is displayed when Device Refresh completes.

7.	� repeatedly to return to the desired screen or menu. This can be done even before device refresh has completed, 
allowing the refresh process to continue in the background.

The time taken to refresh depends on the number of new devices to be found in the lighting system. 
On larger systems, refresh may take up to 20 minutes to complete.
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14. Resetting to Factory Defaults
This procedure returns TouchPanel to its factory settings. After resetting TouchPanel, the next time you switch it on, it will 
behave as if it is being switched on for the first time.

14.1 Resetting to Factory Defaults
1. From           Main Menu select the following:

2.	 to display the Options menu.

3.	 to display the More Options menu.

4.	 to display the Restore Factory Settings menu.

5. Type in the password. This is a precaution against accidental use of this feature.

6.	 to continue.

7. �TouchPanel will reset and behave as if it is being switched on for the first time. To learn how to configure TouchPanel 
from this point, see section 3.

This procedure will cause all settings stored in TouchPanel to be lost, including Screens, Groups, 
Scenes, Scheduled Events, Sequences and Cycles. However, DALI devices store their own scene 
levels and Group information, so that information will not be lost. Background and button graphics 
are also retained. This procedure also restores the default password. 

To learn more about security and password protection, and to find the default password, see 
section 4.

The Factory Reset password cannot be changed. It is provided only as a precaution against accidental 
use of this feature.

	 The Factory Reset password: 	  	 429429
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15. Password Protection
TouchPanel has many configuration options that affect how it will work with the lighting system. All these features are 
accessed via the Hotspot. To prevent accidental or unauthorised access, the Hotspot is protected by a password. Each 
TouchPanel can have a separate password.

TouchPanel is provided with a default password, shown at the bottom of this page, but you can change the password 
whenever you wish. Each screen may be protected by a password. To learn more, see section 7.3. The Restore Factory 
Settings feature is also protected by a password, but this password cannot be changed. To learn more about this, see 
section 14.

If you have forgotten your password, restarting TouchPanel provides an opportunity to enter a new password. When the 
power is restored, password protection is disabled for the first 2 minutes. During this time you can enter the Configuration 
menus and change the password. After this time, password protection will be enabled.

When you have entered a valid password, features protected by the password can be used until the password expires. 
The password expires if you return to a Screen, and do not return to the Configuration menus for more than 20 seconds. 
After this time, if you want to access the Configuration menus you must enter the password again. This ensures that 
TouchPanel’s Configuration menus are protected automatically from accidental or unauthorized access.

If you intend to change the default password, we recommend that you use the same password for all 
TouchPanels in the lighting system, as this is easier to remember and reduces the possibility of having the 
incorrect password for a particular TouchPanel.

Screens can also be protected by a password. To learn more, see section 8.3.

15.1 Changing the password
1. From          Main Menu select the following:

2.	 to display the Options menu.

3.	 to display the More Options menu.

4.	 to display the Set Password menu.

5. Type in a new password and press        . Then retype the password to confirm it.

6.	 to save the changes.

Make a note of the password in the space provided at the bottom of this page. If you forget the password, then 
you will not be able to access TouchPanel’s configuration options.

  The default password:      924       		    Your custom password: 
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16. Setting the Time, Date, Location and Language
TouchPanel has a built-in clock and perpetual calendar that recognises leap years automatically. The clock and calendar 
are used by the Scheduler to determine when to trigger scheduled events. The time and date can be displayed on a Screen 
by adding a Clock control. To learn how to do this, see section 8.5.

16.1 Setting the Time Zone and Location
TouchPanel calculates local dawn and dusk times according to the selected time zone and location. This information 
allows you to schedule events that are triggered at or around dawn or dusk.

1. From         Main Menu select the following:

2.	 to display the Options menu.

3.	 to display the Regional Settings menu.

4.	 to display the Time Zone and Location menu.

5.	 to display the Region list.

6. �Select a region of the world. To set a time zone that does not relate to a specific region select Worldwide.

7.	 to save the changes.

8.	 to display the Locale list.

9. Select the city nearest to your current location.

10.	 to save the changes.

11. �Use          ,            ,           and           to set the longitude and latitude of your current location. These values default to the 
current locale but you can adjust them so that they refer to your exact location.  The closer these values are to your 
current location,the more accurate the dawn and dusk time calculations will be.

12.	 to save the changes.

Although TouchPanel calculates dawn and dusk times accurately, the location of your building will affect 
actual dawn and dusk times. For example, if your building is in a valley then dawn may occur later and 
dusk earlier than the dawn and dusk calculations predict.

Many websites provide longitude and latitude information. For example, you can find the approximate 
longitude and latitude of your location at the Space Environment Center website: www.sec.noaa.gove/
Aurora/globeNE.html.
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16.2 Setting the Date and Time
1. From           Main Menu select the following:

2.	 to display the Options menu.

3.	 to display the Set Date And Time menu.

4.	 and          to set the date and time.

5.	 to enable or disable Daylight Saving (also known as Summer Time).

6.	 to save the changes.

Daylight saving Time is considered by TouchPanel when it calculates dawn and dusk times for 
Scheduled Events. To learn more about Scheduled Events, see section 9.

In the event of power supply failure, TouchPanel’s clock will continue to keep time for approximately 
two days using its internal power reserve. When power is restored, if the clock is no longer keeping 
time you will be prompted to set the date and time.

16.2 Setting the Date and Time
1. From          Main Menu select the following:

2.	 to display the Options menu.

3.	 to display the Regional Settings menu.

4.	 to display the Language menu.

5. Select the language you want to use.

6.	 to save the changes.
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17. Setting the Backlight
TouchPanel’s screen is backlit so that you can see it in low lighting conditions. When TouchPanel is not being used, the 
backlight level can be set to dim automatically so that it is not intrusive.

So that you can see TouchPanel’s controls when you need them, when the backlight has dimmed, touch the screen once 
to brighten the backlight. When dimmed, TouchPanel’s backlight will also brighten when it receives a command from the 
remote control.

17.1 Setting the Backlight Timeout
1. From          Main Menu select the following:

2. 	 to display the Options menu.

3. 	 to display the More Options menu.

4. 	 to display the Backlight Settings menu.

5. Select a backlight timeout. If you select Backlight Timeout Disabled, the backlight will remain on at all times.

6. 	 to save the changes.
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18. Cleaning
TouchPanel’s touch-sensitive screen will respond to any touch, so you should enter its cleaning mode before cleaning 
it. This mode switches off the screens touch-sensitive features for 20 seconds so you can clean the screen without 
inadvertently affecting the lights or selecting on-screen menu items. This is the only Pop up menu feature that is not 
protected by the password.

Cleaning the bezel and screen

Wipe the surface with a soft, damp, non-abrasive cloth. Dampen the cloth only 
with water or isopropyl alcohol. If you are using a cleaning spray, spray it onto the 
cloth, not onto TouchPanel.

Use a cotton bud or soft brush (such as a toothbrush) to clean dirt from the 
corners and recesses of the screen. Dampen only with water or isopropyl 
alcohol.

Before cleaning TouchPanel you should first select Cleaning Mode. Do 
not allow TouchPanel to become wet, as electric shock may result.

Isopropyl alcohol is a flammable liquid.

Do not use an abrasive cloth, or scourer. Do not apply liquid directly to 
TouchPanel. 

Do not apply other detergent, polish, cleaning agent, solvent, caustic agent, 
ammonia-based window cleaner, or vinegar-based solution as these may 
damage the screen or tarnish the bezel.  

Do not disassemble TouchPanel or remove it from the wall to clean it. Do not 
immerse TouchPanel in any liquid.

18.1 Using Cleaning Mode while not in Editing Mode
1.  While TouchPanel is not in editing mode, press the Hotspot to display the Enter Password screen.

2.	 to enter Cleaning mode.

3. �A 20-second countdown will be shown on the screen. The screen will not respond to touch until the countdown has 
ended. You can clean the screen surface during this time
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18.2 Using Cleaning Mode while in Editing Mode
1. From          Main Menu select the following:

2.	 to display the Options menu.

3.	 to display the More Options menu.

4.	 to enter Cleaning mode.

5. A 20-second countdown will be shown on the screen. The screen will not respond to touch until the countdown has 
ended. You can clean the screen surface during this time.

Be sure to instruct cleaning staff about how to enter cleaning mode, and about 
how to clean TouchPanel.

18.3 Leaving Cleaning Mode
TouchPanel remains in Cleaning Mode for 20 seconds. You cannot leave Cleaning Mode manually.

19. Calibrating the Screen
TouchPanel is supplied with the screen already calibrated. However, you may re-calibrate the screen manually if 
necessary.

19.1 Re-calibrating The Screen
1. From         Main Menu select the following:

2.	 to display the Options menu.

3.	 to display the More Options menu.

4.	 to start the calibration process.

5. Follow the on-screen prompts.

For greater accuracy when 
re-calibrating the screen, we 
recommend that you use a 
stylus or similar soft-tipped, 
non-writing device.
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20. Problems and Solutions
If you encounter a problem with TouchPanel, the following items may provide the answer you need. If the problem remains 
unresolved, please contact your TouchPanel supplier for assistance.

TouchPanel is executing commands without being touched
TouchPanel may be running a sequence or cycle, or may be responding to commands from another control. Check that the 
screen is dry and clean. To learn about cleaning TouchPanel, see section 18.

The wrong item is being selected on the screen
If you select an item on the screen but a different item appears to be selected, it may be that the screen needs to be re-calibrated. 
To learn how to calibrate the screen, see section 19.

Scheduled Events happen at the wrong time
Check that TouchPanel’s clock is set to the correct date and time. To learn more, see section 16.

I have forgotten the TouchPanel password
You may still be using the default password. To find the default password, see section 15.

Screen contrast is poor
This may happen if the ambient temperature is above 40°C or below 0°C.

The Controls list shows an unrecognised control
	� The Unrecognised Control icon will appear if TouchPanel detects a control that it does not recognise. This may 

happen if communications are poor (check cables), or it may be that the control is one that Helvar has developed 
since this version of TouchPanel was assembled. If this is the case, a software update may be available, which 
provides support for this control. Contact your supplier for assistance. To learn about Digidim Controls, see 
section 7.
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20.1 Helvar Customer Support
Helvar has representatives in 49 countries, which can provide support in your local language. For information about Helvar 
support facilities in your country, see the Helvar website at www.helvar.com.

Helvar Regional Support with a Service Agreement
Helvar provides a range of support services that give you access to our technical expertise.
We offer the following services:

•	 Field service on a contract or request basis.
•	 Final commissioning and configurating of your new lighting system.
•	 Bench service for those occasions things cannot be repaired on site.

How to contact the Service Department

Post Helvar Merca Limited, Hawley Mill, Hawley Road,
Dartford, Kent; DA2 7SY, UK

Telephone (Main) +44 (0) 1322 222211
Telephone (Service) +44 (0) 1322 282265
Fax +44 (0) 1322 282216
Email service@helvar.com

20.2 Finding information about TouchPanel
1. From          Main Menu select the following:

2.	 to display the Options menu.

3.	� to display the About screen. This screen provides contact information and, at the bottom of the screen, shows the 
current operating mode and version of software that TouchPanel is using.

4.	 to close the About screen.
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21. About the Lighting System
To help you get the most from TouchPanel, especially if you intend to customize its operation, it is useful to know a little 
about your lighting system, and how it can be controlled using TouchPanel’s features. We therefore recommend that you 
take a few minutes to read the following sections carefully before proceeding to other parts of this guide.

This guide provides an introduction to lighting and Digidim, so that you can use TouchPanel 
effectively. To learn more about these subjects, see Digidim Lighting Control Designing, Specifying 
and Installing (Document 7860038 (available separately). If using TouchPanel in a Lighting Router 
system, see the online help provided with Workshop software (available separately), or contact 
Helvar Customer Support for details of training courses.

21.1 About Lighting Circuits
A lighting circuit is a collection of one or more lights that are connected together and therefore work together. A typical 
room may include one or more circuits, each one controlled by an on/off switch,  or dimmer. Each channel of a dimmer is 
wired to a circuit of loads (usually lights).

21.2 About Broadcast And Groups
When a command is sent from a control panel, it reaches every device in the lighting system, but usually we only want a 
few devices to respond to that command. We achieve this by addressing commands to specific Groups, so that only devices 
in the Group respond. However, we may want to set a level for all loads in the lighting system. To do this we send the 
command without specifying a Group. In other words, we send it as a Broadcast.
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21.3 About Lighting Scenes
In simple terms, a scene is an arrangement of lighting that suits a particular purpose. For example, a dining room may 
need practical lighting when holding a meeting there, atmospheric lighting when dining or entertaining, other lighting for 
presentation purposes and, of course, occasionally no lighting at all. Each of these lighting arrangements is stored as a 
scene. (There is usually also a scene in which all the lights are off). When you press a Scene Button on TouchPanel, you are 
selecting one of these scenes.

Technically speaking, scenes are actually collections of light levels for a collection of loads. The example below shows four 
scenes, each one comprising four loads. (Note that each scene could comprise many more loads). In this case, each scene 
has been assigned to a Scene Button on a typical Screen.

The loads in each scene have been set to specific levels. 
Notice that the loads do not have to be set to the same 
level as other loads. You can change any scene so that each 
load provides exactly the light level that you need, or assign 
a different scene to each Scene Button. To the right you 
can see that Scene 1 has been changed so that each load 
provides a different level of light.

To learn how to edit scenes, see section 6.1. To learn how to 
assign scenes to Scene Buttons on a Screen, see section 8.8.

Loads Loads

LoadsLoads

Loads

Scene 1 Scene 2

Scene 3 Scene 4

Scene 1

OFF
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22. Icon Quick Reference
Accept Changes Colour picker Pop up menu

hotspot
Time Zone

Cancel changes Change screen
background picture

Configuration
menus

Location

Add mode Change button
appearance

Options menu Region

Properties mode Button control Other functions
menu

Locale

Delete mode Clock control Temperature/
Air Con Control

Language

Return to previous
screen

Label Fan speed control

Move mode Text justify - centre Screen Identification mode

Move down or
change value

Text justify - left Remote control Address

Move left or change
value

Text justify - right Date and time Refresh devices
(loads)

Move right or
change value

Theme for screen Clock format Scene

Move up or change
value

Layout for screen Loads Scene Block

Stretch vertically Return screen Controls Group

Stretch horizontally Return screen
timeout

Constant Light Ignore scene

Shrink vertically Edit a name or
caption

Sequences and
Cycles menu

Selected item is not
used

Shrink horizontally Cycle Fade time

Resize Scheduled event Sequence

Calibrate the screen Button or event
action

First link in a
sequence or cycle

Information about
TouchPanel

Scheduled event
trigger day

Link in a sequence
of cycle

Backlight timeout Scheduled event
trigger time

Final link in a
sequence

Cleaning mode Dawn Link duration

Password entry Dusk

Restore factory
settings

Days of the Week



Helvar 924 LCD TouchPanel: Installation and User Guide56 www.helvar.com   

Technical Data

Connections
DALI cable: 2-wire, 1.0 mm² – 1.5 mm² 

Example: Belden 8471
S-DIM cable: Low-loss, multistranded RS485 type, 

up to 1000 m, 0.22 mm² – 1.5 mm². 
Examples: Belden 8102 or Alpha 
6222C. One twisted pair for A and B 
(85 Ω – 100 Ω impedance), one core 
or twisted pair for 0 V, and shield 
for screen.

Ethernet: Not used. This port will be 
supported in a future firmware 
release.

Power
Power supply: 14 VDC – 50 VDC 

externally supplied 
Power Supply: 401 or 402, 
or dimmer packs 91200, 99300, 
99400. 14 to 50 V DC. 401 or 402 
recommended.

Mechanical data
Dimensions: 146 mm × 88 mm × 35 mm
Weight: 350 g
IP code: IP30
Back box: Requires double-gang UK back box 

(provided in the package)

Operating and storage conditions
Ambient temperature: 0 °C to +35 °C 
Relative humidity: Max. 90 %, noncondensing
Storage temperature: –10 °C to +70 °C

Conformity and standards
Emission: EN 55022 Class A
Immunity: EN 55024
Safety: EN 60950–1
Environment: Complies with WEEE and RoHS 

directives.

Software
System: Helvar DIGIDIM or standalone 

system
Software: Helvar Designer and Touch-Panel
DALI addresses: See TouchPanel user manual
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